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Techno Clone - 1
Chapter - 1 — Computer-A Machine

Warm Up
1.	 Machine is a man-made thing.
2.	 Computer, fan, bus, calculator.
3.	 Yes, computer is a machine.

Exercise
A.	 1.	 (b) man-made things.	 2.	 (c) Both (a) and (b)
	 3.	 (a) Television	 4. (c) Machines make our work difficult.
B.	 1.	 fuel	 2.	 man-made	 3. desktop	 4. tablet
C.	 1.	 F	 2. T	 3. F	 4. T
D.1.	Computer makes our work easier. It helps us to do different tasks.
2.	 Doll, book, television, bag, etc. are man-made things.
3.	 Machines make our work easy and faster. They also save our time.
4.	 Desktop computer, laptop and tablet are types of computer.	
E.	 A.	 F	 B. E	 C. B	 D. E	 E. B	 F. F

Activity Zone
A.	 Green — Flower, Dog		  Blue — Watch, bag, pen, car
B.	 (a)	Refrigerator	 (b) Aeroplane	 (c) Desktop computer
C.	 Do it yourself

Project Work

T E L E V I S I O N

A E R O P L A N E Y

M F T O A S T E R E

I A C B O A T O M V

X N A M O B I L E Z

E Q R B I C Y C L E

R C A M E R A V W C

Television, Aeroplane, Mixer, Fan, Car, Toaster, Boat, Mobile, Bicycle, 
Camera
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Chapter - 2 
Warm Up
1.	 Eyes, nose, mouth, ears, etc.
2.	 Monitor, mouse, keyboard, CPU, etc.

Activity Zone

C O M P U T E R

K E Y B O A R D

M O N I T O R

C P U

M O U S E

Exercise
A.	 1.	 (a) Monitor	 2.	 (c) all of these	 3.   (a) Central Processing Uuit
	 4.	 (c) CPU	 5.	 (c) Keyboard
B.	 1.	 four	 2.	 Mouse	 3.	 Keys	 4.	 CPU	 5.	 Speakers
C.	 1.	 T	 2. F		 3. T	 4. F	 5. T
D.	 1.	 CPU	 2.	 MONITOR			   3.	 MOUSE
	 4.	 SPEAKERS			   5.	 KEYBOARD
E.	 1.	 Monitor	 2.	 CPU	 3. Keyboard		  4. Mouse
F.1.	 Monitor, Mouse, Keyboard and CPU are the main parts of a computer.
2.	 CPU is the most important part of a computer.
3.	 Keyboard is used to type in numbers and letters to the computer.
4.	 Printer, speakers and scanner are the additional parts of a computer.	
5.	 Printer is used to take a printout on a paper.

Activity Zone
A.	 Do it yourself
B.	 1, 3	

Project Work
W O K E Y B O A R D

O S C A N N E R P M

V M P R I N T E R W

M O N I T O R C I Q

Q U S P Q C Q P N U

Z S O N M Y M U T C

H E A D P H O N E W

S P E A K E R S R O

Keyboard, Scanner, Mouse, Monitor, Printer, Headphone, Speakers, CPU.
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Chapter - 3 
Warm Up
1.	 Yes, I have seen a computer in my school library.
2.	 It is used in a library, bank, hospitals, schools, home, etc.
3.	 In a shopping mall, office and at a railway station.

Exercise
A.	 1.	 (c) both a and b		  2.	 (a) sums
	 3.	 (a) games	 4.	 (a) greeting card	 5.	 (b) office
B.	 1.	 music	 2.	 greeting	 3. messages	 4. video	 5. sums
C.	 1.	 T	 2. F		 3. F	 4. F	 5. T
D.	 1. (b) Listen to Music	 2. (a) Typing Letters		
	 3. (d) Playing Games	 4.  (e) Drawing Pictures		
	 5. (f)  Watching Movies	 6. (c) Solving Sums
E.1.	 Computers are used at homes, schools, banks and libraries.
2.	 We can solve sums on a computer and can design a greeting card on it.

Activity Zone
M U S I C Q S L

O N R B O T Y E

V V V P E Y R A

I W Q N T P E R

E R L I G I E N

S Y O E S N W I

M E S S A G E N

Q D R A W I N G

Project Work : Do it yourself

Chapter - 4 
Warm Up
1.	 Yes, we obey rules in school.
2.	 Yes, we obey rules while crossing the road.
3.	 Yes, we follow rules using a computer.

Exercise
A.	 1.	 (a) electricity	 2. (a) CPU	 3.	 (a) Keyboard
	 4.	 (c) You should always sit too close to the monitor.
B.	 1.	 rules	 2.	 slot	 3. monitor	 4. straight	
C.	 1.	 T	 2. F		 3. T	 4. T
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D.1.	We should follow some rules to make the computer safe.
2.	 We should use headphones so that we do not disturb others.
3.	 A computer is very sensitive as it stops working if we do not clean it.
4.	 It can cause a injury if a correct posture is not maintained while using 

a computer.

Activity Zone
	 1.  	 2. 	 	 3.  	 4.  	 5. 	 	6.  

Project Work : Do it yourself

Chapter - 5 
Warm Up
1.	 Yes, I have seen it.		  2.	 Yes, I have seen it.
3.	 Real mouse is a living one and a computer mouse is a non-living one.

Exercise
A.	 1. (b) small      2.  (c) both a and b	   3. (b) double click   4. (a) left click
B.	 1.	 two	 2. wire		  3. move		 4. pointer
C.	 1.	 T	 2. F		  3. T		  4. F	
D.	 1.	 (d) Change the location of an object.  
	 2.	 (a) Click the left button once.		
	 3.	 (b) Click the right button once.	
	 4. 	 (c) Click the left button twice.		
E. 1.	There are two buttons in a mouse.
2.	 A mouse helps us to draw pictures, play games, point and select any 

item on the monitor.
3.	 The mouse pointer is the arrow used to point at the monitor.
4.	 Pressing the left mouse button once is called left click.
5.	 Pressing the mouse button twice is called double click.

Activity Zone
A.	 1.	 M	 O	 U	 S	 E
	 2.	 K	 E	 Y	 B	 O	 A	 R	 D
	 3.	 M	 O	 N	 I	 T	 O	 R
B.	 4. P

1. M R

O 3. C L I C K

U N
2. S E L E C T

E E
5. D R A W
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Project Work
T G S P O G V S

A C E O P C O M

I C L I C K C A

L F E N Q D W L

D A C T M R R L

U S T E R A M Q

M T O R L W N E

P L A Y G A M E

Chapter - 6 
Warm Up
1.	 We use a pen or pencil to write a notebook.
2.	 No, we do not use the same things to write on a computer.
3.	 We use keyboard to write on a computer.

Activity

	
	 ^	 @	 (
	6	 2	 9

Exercise
A.	 1.	 (c) keyboard		 2.    (b) keys		  3.   (a) alphabet keys
	 4.	 (b) enter key		 5.  (a) delete key
B.	 1.	 typing	 2.	 number	 3. spacebar	 4. arrow	 5. caps lock	
C.	 1.	 F	 2. F		 3. T	 4. F	 5. F
D.	 1.	 (b) to type numbers	 2.	 (e) longest key
	 3.	 (d) 26 keys			   4.	 (c) to erase
	 5.	 (a) type capital letters when caps lock is off
E.	 1.	 Alphabet keys, number keys, special keys, function keys are some 

of the keys on the keyboard.
	 2.	 Alphabet keys are used to type alphabet.	
	 3.	 Number keys are used to type numbers.
	 4.	 Special keys are used to do special functions.
	 5.	 Function keys are used to perform different functions.

Activity Zone
A.	 1.	 Enter key	 2. Spacebar key	3. Arrow key	
	 4.	 Alphabet key	 5. Caps lock key
B.	 1. 	 c	 2. b		 3. d	 4. a
C.	 1.	 a	 2. a		 3. b	 4. a
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Project Work
E N T E R S S L Q

A U R D R P A I V

L M A A Q E S Q W

P B M N C C M V M

H E A C V I I D D

A R S H M A T S L

B C A P S L O C K

E A S H O K K U M

T S P A C E B A R

Chapter - 7 
Warm Up
1.	 Open the door
2.	 Open the lock
3.	 Switch it on

Activity
	 1 	 Switch ON the main power button.
	 2 	 Press ON/Restart button on the CPU.
	 3 	 Switch ON the monitor

Exercise
A.	 1.	 (a) 
		 2.	 (c) Switch ON the main power.
	 3.	 (b) Uninterrupted Power Supply
	 4.	 (a) Click on Shut Down
B.	 1.	 electricity	 2.	 turn off	 3. shutdown	
C.	 1.	 F	 2. F		 3. F	 4. F	
D.	 Step 1. Turn on the Power Switch.
	 Step 2. Switch ON the UPS.
	 Step 3. Switch ON the CPU.
	 Step 4. Switch ON the monitor.
	 Step 5. Welcome screen appears.
E.	 1.	 Step 1. Turn on the power switch.
		  Step 2. Switch ON the UPS.
		  Step 3. Switch ON the CPU.
		  Step 4. Switch ON the monitor.
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	 2.	 We have to shut down the system properly so that computer 
functions properly.

	 3.	 Steps are as follows:
		  Step 1. Click on start button.
		  Step 2. Now click on shut down button.
		  Step 3. When the screen becomes blank, switch OFF the power 

button on the monitor.
		  Step 4. Switch OFF the UPS.
		  Step 5. Switch OFF the main power button.
	 4.	 It is a process that starts when you switch ON the CPU and run till 

you see the desktop on computer.

Activity Zone
A.	 1.	 b	 2. a	 3. d	 4. c	
B.	 2.	 	 3. 

Project Work
1.	 S T A R T B U T T O N 	

2.	 S H U T D O W N

3.	 M O N I T O R

4.	 U P S

5.	 M A I N P O W E R 	

Chapter - 8 
Warm Up
1.	 Yes, I like to draw pictures.
2.	 We use pencil, colours, an eraser, etc. to draw on paper.
3.	 No, we do not use the same things to draw pictures on a computer.
4.	 We need various tools of MS-PAINT to draw on a computer.

Exercise
A.	 1.	 (a) 	 2. (b) 	 3. (a) 	 4. (b) 
B.	 1.	 Drawing	 2.	 Pencil	 3. Paint	 4. New	 5. Save	
C.	 1.	 T	 2. F		 3. T	 4. T	 5. F	
D.	 1.	 MS-PAINT is a program that lets you paint on the computer.
	 2.	 Steps are as follows:
		  Step 1. Click on the start menu.
		  Step 2. Click on Window Accessories.
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		  Step 3. Then select Paint from the option. 
	             The Paint home screen will appear.

	 3.	 Pencil tool, Eraser tool, Brush tool, Fill with color tool and line 
tool are some of the tools in MS-Paint.

Activity Zone : Do it yourself

Model Test Paper-1
A.	 1.	 (a)  Monitor	 2. (c) both a and b	 3. (b) electricity 
B.	 1.	 Desktop	 2.	 Mouse	 3. Mistake	 4. Rules	
C.	 1.	 F	 2. T		  3. F	 4. T	
D.	 1.	 Schools, hospitals, banks, office, etc. are some places where 

computer are used.
	 2.	 Features of computer are:
		  (a) A computer never makes any mistake.
		  (b) A computer makes our work easy and fast.
	 3.	 Monitor, Mouse, Keyboard, CPU are the main parts of a computer.
	 4.	 A computer is very sensitive as it stops working if we do not clean 

it.

Model Test Paper-2
A.	 1.	 (c)  both a and b 	 2. (a) alphabet keys	
	 3.	 (c) Switch ON the main power	 4. (a) Lines
B.	 1.	 Wire	 2.	 Spacebar	    3. Electricity	          4. Drawing
C.	 1.	 F	 2. F		 3. F	 4. F	
D.	 1.	 Mouse is used to draw pictures and play games.
	 2.	 Special keys are used to do special function.
	 3.	 Function keys are used to perform different functions.
	 4.	 MS-Paint is a program that lets you paint on the computer.

NATIONAL CYBER OLYMPAID 
(Sample Paper)

Logical Reasoning
	 1.	 (b) 13, 21, 29, 45		 2. (c) Wednesday	 3. (d) 50 	
	 4. 	 (b) 74	 	 	 5. (c) fifty eight

Computers and Information Technology
	 1.	 (d) TV			   2. (d) CPU Box		
	 3.	 (c) many things		 4. (c) Monitor			 
	 5.	 (b) Mouse
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Techno Clone - 2
Chapter - 1 

Warm Up
1.	 Machine is a device that helps us to do our work easily and quickly.
2.	 We use machine because it helps to do various things.
3.	 Yes, computer is also a machine.
4.	 Computer needs electricity to run.

Exercise
A.	 1.	 (b) electricity		  2.	 (a) fast
	 3.	 (c) A computer has feelings and emotions
	 4.	 (b) Desktop Computer	 5.	 (b) Textbook
B.	 1.	 Electricity	2.	 Memory	 3. Desktop	 4. Palmtop	 5. Positive
C.	 1.	 T	 2. T	 3. F	 4. T	 5. F
D.	 1.	 (a) Desktop computer	 2.	 (d) Laptop
	 3.	 (c) Tablet computer	 4.	 (b) Smartphone	
E.1.	 A machine is a device that helps us to do our work easily and quickly.

2. Computer Human Being

a. A computer works very 
fast.

a. A human being cannot work 
very fast like computer.

b. A computer cannot think. b. A human being can think.
3.	 Two advatages of computer are:
	 (a)	 Speed - A computer performs functions very fast and calculate 

million of sums in seconds.
	 (b)	 Diligence - A computer can work for long hours without getting 

tired.
4.	 Two disadvantages of computer are:
	 (a)	 Health Risks - If we do not use computer properly, it can result in 

injuries or disorders of hands, eyes, neck, etc.
	 (b)	 Impact on Environment - The e-waste releases, dangerous toxic 

materials which are harmful for the environment.
5.	 Different types of computer are desktop computer, laptop computer, 

tablet computer, smart phone.

Activity Zone
A.	 Works with very fast speed 
	 Needs Instruction
	 Internet
	 Accuracy in work			   B. Do it yourself.
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Project Work
2. Advantages Disadvantages

a. A computer can work 
for long hours without 
getting tired.

a. Many people use computer in a 
negative way. They play games 
and do chat that is a waste of 
time.

b. A computer never 
makes mistakes.

b. Some people use computer for 
negative activities like hacking, 
stealing data from computer.

Chapter - 2 
Warm Up
	 1.	 Yes	 2.	 Yes	 3.	 Yes	 4.	 Yes	 5.	 No

Activity
	 1.	 Railway station	 2. School	 3. Hospital	 4. Bank

Exercise
A.	 1.	 (c) both a and b	           2.   (c) all of these
	 3.	 (c) railway station       4.   (a) design homes and buildings
	 5.	 (c) Calculator
B.	 1.	 MS Word	 2. MS Paint	 3. Internet   4. Employees	  5. Patients
C.	 1.	 T	 2. F		 3. T	 4. F	 5. T
D.	 1.	 Bank	 2. School	 3. Shop	
E.	 1.	 Hospital, school, office are the places where computers are used.	
	 2.	 To deposit or withdraw money.
	 3.	 To book and cancel tickets.
	 4.	 To make bills.
	 5.	 To tell people when trains will arrive or depart.

Activity Zone
S C H O O L

H O O F A O

O B S F I S

M A P I R H

E N I C P O

M K T E O P

V B A N R R

W S L Q T V
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Project Work
	 1.	 SCHOOL	 2. HOME	 3. OFFICE	 4. BANK

A I R P O R T C A

Z C P H Z S E Z F

S C H O O L W I J

K M N M C V P X O

A L B E P N Q U L

L E A F K B A N K

H O S P I T A L G

	 1. AIRPORT	 2. HOME	 3. SCHOOL	 4. BANK	 5. HOSPITAL

Chapter - 3 
Warm Up
	 1.	 Making Juice

		  P 		  O 		  I

	 2.	 Making a dress

		  P 		  O 		  I

Activity

	 I 	 O 	 O 	 I 	 O 	
Exercise
A.	 1.	 (a) keyboard		 2.    (c) both (a) and (b)	 3.	 (c) keyboard
	 4.	 (b) compact disc		 5.	 (a) Mouse
B.	 1.	 input	 2. 104	 3. Mouse   4. Microphone	  5. Monitor
C.	 1.	 T	 2. T		  3. F	 4. T	 5. T
D.	 1.	 (c) Monitor		  2.(d) Printer  	 3. (a) Pendrive		 4. (b) Scanner	
E.1.	 Device that help us to provide data and instructions to the computer 

are called input devices. Example- keyboard, mouse, scanner, etc.
2.	 Parts of the computer that give us the final output after processing 

are called output devices. Example- monitor, speakers, printers, etc.
3.	 The devices that store data and instructions before processing and 

output after processing are called storage devices. Examples- CD/
DVD, pendrive, memory card, etc.

4.	 Pendrive is a small sized storage device with huge capacity to store 
data and information.

5.	 Memory card is a small chip type storage device.

Activity Zone
	 (a)	 Keyboard 		  (b) Mouse 		  (c) Scanner 	
	 (d) Printer 		  (e) Pendrive 
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Project Work
	 1.	 Input	 2. Output	 3. Mouse	 4. Joystick
	 5.	 Printer	 6. Process

Chapter - 4 
Warm Up : Do it yourself

Activity

Exercise
A.	 1.  (b) 104	 2. (a) 2	 3. (b) Right Arrow	 4. (b) Ctrl	 5. (b) Esc
B.	 1.	 Alphabet	 2. Number	 3. Caps lock	 4. Shift	 5. Delete
C.	 1.	 F	 2.	 F	 3.	 T	 4.	 F	 5.	 F

D.	 1.	 (d) Shift key	 2. (a) Ctrl key		 3. (b) Esc key

	 4.	 (e) Backspace key	 5.	 Delete key

E.1.	 Keyboard is used to type in numbers and letters to the computer.
2.	 The Capslock key is used to type letters in capital letters.
3.	 Shift key is a special key that performs many functions.
4.	 These keys are used in games as they allow the player to move in any 

direction.
5.	 The backspace key is used to erase the text to the left of the cursor.

Activity Zone : Do it yourself

Chapter - 5 
Warm up

D
M O U S E P A D

U
L E F T B U T T O N

L
S E L E C T

C D R A G
L R

P R I N T E R
C O
K W

Left Arrow

UP Arrow

Right Arrow

Down Arrow
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Exercise
A.	 1.	 (c) both a and b	 2. (b) optical mouse
	 3.	 (b) Touch pad mouse	 4. (b) clicking		 5. (b) Double-click
B.	 1.	 pointing	 2. optical	 3. three	 4. left-click
C.	 1.	 T	 2. F		 3. T	 4. T
D.	 1.	 (d) To open the menu options.	 2. (e) To select an item.
	 3.	 (b) A mouse without wire.		  4. (a) Found on a laptop.
	 5.	 (c) Works like a scroll wheel.
E. 1.	Mouse is used to point and select items on the monitor.
2.	 Optical mouse, wireless mouse, trackball mouse, touch pad mouse, 

etc.
3.	 Wireless mouse is a mouse without wire.
4.	 Pressing the buttons is called clicking.
5.	 Double-click is used to open a file or documents.

Activity Zone

1.	 M O U S E

2.	 C L I C K I N G

3.	 D R A G G I N G

4.	 M O U S E P O I N T E R

5.	 D O U B L E C L I C K

B.	 1.	 Optical mouse	 2. Wireless mouse   3. Touchpad mouse

Project Work
4. P

1. M O

O 3. C L I C K

U N
2. S E L E C T

E E
5. D R A G
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Chapter - 6
Warm Up : Do it  yourself

Activity Zone
	 1.	 	 R E C T A N G L E

	 2.	 	 P O L Y G O N 	

	 3.	 	 O V A L

	 4.	 	 C U R V E

Exercise
A.	 1.	 (a) Rounded rectange tool	 2.	 (b) Polygon tool
	 3.	 (a) Text tool	 4.  (a) To enlarge the view of a picture
	 5.	 (b) Cut and paste
B.	 1.	 shapes	 2. size	 3. magnify	 4. rotate	 5. crop
C.	 1.	 F	 2. T	 3. T	 4. T
D. 1.	Ms-Paint help you to draw and colour on the computer.
2.	 The tools are line, curve, oval, ractangle, rounded rectangle and polygon.	
3.	 The steps are:  (a) Click on Home tab.
	 (b)	 Click on curve.
	 (c)	 Click on the size box and select the width of the line.
	 (d)	Now drag the mouse to make a line.
	 (e)	 Now click anywhere on the blank area to make a  curve.
4.	 Magnifying a picture helps to see image in a large format.
5.	 The steps are:  (a) Click on the Home tab.
	 (b)	 Click on select from image group.
	 (c)	 Click on cut from clipboard group. The image will disappear.
	 (d)	Click on paste from clipboard group. Your image will be pasted. 

Now select it and drag it to the place where you want to place it.

Warm Up
A.	 Menu, tabs, Title Bar, Minimize Button, Maximize Button, Close 

Button, Drawing Tools, Groups, Color Palette
B.	 Do it yourself

Chapter - 7
Warm Up
	 Black board	 Water bottle	 Paper	 Table
	 	 	 	

Exercise
A.	 1.	 (c) Both a and b	 2.	 (b) Title Bar	 3. (a) each word
	 4.	 (b) Ctrl + B		  5.	 (b) Ctrl + X
B.	 1.	 Control	 2.	 Ribbon	 3.	 WordPad	 4.	 Enter	 5.	 Ctrl + N
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C.	 1.	 T	 2.	 T	 3.	 T	 4.	 F	 5.	 T
D.1.	It is a computer program which is used to type, save and format text.
2.	 The steps are:    a.	 Click on Start button.
	 b.	 Now click Windows Accessories.
	 c.	 In the expanded new menu, click on WordPad.
3.	 The steps are:
	 a.	 On the Home tab in the font group, click on the arrow next to font.
	 b.	 The drop down menu will display a list of all available fonts.
	 c.	 Select the font of your choice.
4.	 The steps are:   a. Click on the File button.
	 b.	 Click on the Save option.
	 c.	 A Save As dialog box will appear.
	 d.	 Type the name of your document in file name box.
	 e.	 Click on Save button, your document will be saved.
5.	 The steps are:   a.	 Click on the File button.
	 b.	 Click on the Exit option

Activity Zone
	 1. Ctrl + B	 2. Ctrl + I	 3. Ctrl + U	 4. Ctrl + X
	 5. Ctrl + C	 6. Ctrl + V

Project Work : Do it yourself

Chapter - 8
Warm Up
	 1.	 Yes	 2.	 Yes	 3.	 Yes	 4.	 Yes

Exercise
A.	 1.	 (a) New	 2.	 (a) Paint	 3. (b) Shapes	 4.	 (b) Eraser
B.	 1.	 17	 2.	 Thumbnail	 3.	 Mascot	 4.	 Left toolbar
	 5.	 Drawing Canvas
C.	 1.	 T	 2.	 F	 3.	 T	 4.	 F	 5.	 T
D.1.	Tux Paint has a simple, easy to use interface. It also has sound effects.
2.	 It is designed and developed by Bill Kendrick of New Breed Software.
3.	 The steps are:   a.	 Click the Start button.
	 b.	 Select All programs.
	 c.	 Click Tux Paint in the list.
	 d.	 Click Tux to open it in the full screen mode or Tux paint windowed 

to open it in a small window.
4.	 To open a file in the TuxPaint follow the given steps:
	 a.	 Select the open option from the tools toolbar.
	 b.	 Select the drawing which is to be opened.

Activity Zone : Do it yourself           Project Work : Do it yourself
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Model Test Paper-1
A.	 1.	 (b) electricity		  2.	 (c) all of these
	 3.	 (b) keyboard			  4.	 (b) ESC
B.	 1.	 electronic	 2.	 MS-Paint	 3.	 104	 4.	 Caps lock
C.	 1.	 T	 2.	 F	 3.	 T	 4.	 F
D.1.	a.	 A computer can work for long hours without getting tired.
	 b.	 A computer never makes mistakes
	 c.	 A computer can store large amount of information.
2.	 Schools, hospitals, banks are some of the places where computers are 

used.
3.	 Devices that help us to provide data and instructions to the computer 

are called input devices.
	 Example- Keyboard, mouse, scanner.
4.	 Backspace key is used to erase the text to the left of the cursor.

Model Test Paper-2
A.	 1.	 (c) Both			   2.	 (b) Polygon tool
	 3.	 (b) Title Bar			   4.	 (b) Eraser
B.	 1.	 Pointing	 2.	 Magnify	 3.	 Ctrl + N	 4.	 17
C.	 1.	 F	 2.	 T	 3.	 T	 4.	 F
D.1.	Double-click is used to open a file of document.
2.	 It helps you to draw and colour on the computer.
3.	 The steps are :
	 a.	 Click on the Home tab.
	 b.	 Click on select from Image group.
	 c.	 Select the image by dragging the mouse.
	 d.	 To copy the image, click on Copy from clipboard group.
	 e.	 Click on paste from clipboard group to paste the image.
4.	 Tux paint is simple and easy to use interface. It also has sound effects.

National Cyber Olympiad  
(Sample Paper)

Logical Reasoning
	 1.	 (c) Blue, Red			  2.	 (b)	 3.	 (a) 2

Computer and Information Technology
	 1.	 (d) Booting			   2.	 (c)
	 3.	 (b) then clicking on the ‘Shut down’
	 4.	 (C) CPU
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Techno Clone - 3
Chapter - 1 

Warm up
	 1.	 Monitor	 2.	 CPU	 3.	 Speakers

Activity 1
	 1.	 Monitor	 2.	 Printer	 3.	 Keyboard	   4.  Mouse	 5.	 UPS
Activity 2
A.	 1.	 Mouse	 2.	 Keyboard	 3.	 Joystick
	 4.	 Touchpad	 5.	 Scanner	 6.	 Webcam

Exercise
A.	 1.	 (c) MS-Windows	 2.	 (c) Joystick
	 3.	 (b) Printer			   4.	 (c) MS-Windows
B.	 1.	 Hardware	 2.	 Input	 3.	 Printer	 4.	 Joystick
C.	 1.	 F	 2. T	 3. T	 4. T
D.	 1.	 (e) MS-Windows	 2.	 (b) MS-Paint
	 3.	 (c) CD	 4.	 (a) Printer	 5.	 (d) Keyboard	
E.1.	 Hardware refers to the parts of the computer which we can see and 

touch. 
	 Example- Printer, Scanner, Mouse, Keyboard, etc.
2.	 Software refers to the programs. It helps in the functioning of a 

computer. We cannot see and touch software.
	 There are two types of software system software and application 

software.
3.	 Input devices are the devices through which we enter data and 

instructions. Output devices are the ones which display the 
information and result.

	 Example of input devices - Keyboard, Mouse, etc.
	 Example of output devices - Printer, Monitor, etc.
4.	 System Software - It refers to the files and programs that make up your 

computer’s operating system. Example - MS-DOS, MS-Windows, 
Linux, etc.

	 Application Software- It is the software which enables you to perform 
some specific tasks on the computer like typing letters, drawing 
pictures, watching movies, etc.

	 Example - MS-Office, MS-Paint, etc.

Activity Zone
A. System Software Application Software

Windows, Linux Microsoft Word, Microsoft Excel, Microsoft 
Paint, Winzip, Clean up, Car racing 
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B.	 1.	 Software	 2.	 Operating System	 3.	 Windows
	 4.	 Application
C.	 1.	 Computer	 2.	 Microphone	 3.	 Output	 4.	 Scanner
	 5.	 Trackball	 6.	 Speaker	 7.	 Keyboard	 5.	 Joystick

Project Work : Do it yourself

Chapter - 2 
Warm Up
	 1.	 Windows			   2.	 Windows logo key + M
	 3.	 Minimize, Maximum, Close are the main components

Activity
	 Recycle Bin, Start Button, Taskbar, Notification Area, This PC

Exercise
A.	 1.	 (b) Microsoft		  2.	 (c) Both a and b
	 3.	 (a) Right	 4.	 (a) Screen saver		 5.	 (a) Desktop
B.	 1.	 Windows	 2.	 Icons	 3. 	 Desktop	 4. GUI
	 5.	 Notification
C.	 1.	 F	 2. F		 3. T	 4. T	 5. T
D.1.	Windows manages all the functions of a computer and makes it run.	
2.	 The first screen that appears on the screen is known as Desktop
3.	 The three main sections of taskbar are Start button, Quick launch icon 

and the Notification area.
4.	 The right side of the taskbar is called Notification area.
5.	 We can change the screen saver by following same steps:
		 a.	 Right-click on the blank area of the desktop.
	 b.	 From the shortcut menu, click on the personalize option.
	 c.	 A new window will open, click on the screen saver option.
	 d.	 Go to the screen saver option for selecting the desired screen saver 

and click on drop down arrow.
	 e.	 A preview will be displayed.
6.	 Steps to shut down the computer:
	 a.	 Click on the start button.
	 b.	 Now select shut down option.
	 c.	 Computer will be shut down.

Activity Zone
A.	 1.	 Microsoft	 2.	 Desktop	 3.	 Icons
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B.

R S N J A N M O H A N T

O B A C K G R O U N D Y

J S M O T H E R I O E L

A H T A S K B A R S S O

S R O H T I O N S K V

M E K B U T T O N P T S

O Y T T T L O V E U O S

H A R O D S E L E C P U

A S S C O M P U T E R S

N P U W I N D O W S M

T I C O N S T U B A T I

S C R E E N S A V E R

Project Work : Do it yourself

Chapter - 3 
Warm Up
	 1.	 MS-Word	 2.	 Two	 3.	 We click on start button

Activity
1. Ribbon	 2. Slider Zoom	 3. Title Bar	 4. File Tab	 5. Minimize

Exercise
A.	 1.	 (c) Document		  2.	 (a) Notebook
	 3.	 (c) Ctrl+S	 4.	 (c) Ctrl+End			  5.	 (c) Home
B.	 1.	 (b) move to the beginning of the line
	 2.	 (a) move to the top of the document
	 3.	 (d) move to the end of the document
	 4.	 (c) to save			   5.	 (e) for new document
C.	 1. Wordpad	 2. File Tab	 3. Title bar	 4. Ctrl+S	 5. Minimize
D.	 1.	 T	 2. T	 3. F	 4. F	 5. F
E.1.	 Creating documents on computer is called word processing.
2.	 The steps are:   a.	 Click on Start button.
	 b.	 Now click All apps.
	 c.	 In the new menu, click on Microsoft Word 2016. MS-word will  

		 open.
3.	 It is present on the title bar and has commands that are used 

frequently.
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4.	 The steps are:  
	 a.	 Click on the file tab. The back-stage view will appear.
	 b.	 Click on new option.
	 c.	 Click on blank document under available templates.
	 d.	 Click on create button. New Blank document will appear on screen.
5.	 The steps are:   a.  Click on file tab.
	 b.	 Click on the Save As option.
	 c.	 Select the location where you want your document to be saved in  

		 the computer.
	 d.	 Type the name of the document in file name box.
	 e.	 Click on save. Your document is saved.

Activity Zone
Across
	 1.	 TITLE BAR			   6.	 CURSOR
Down
	 2.	 WORK AREA	          3.   RIBBON 	 5.	 SCROLL

Project Work : Do it yourself

Chapter - 4 
Warm up
	 1.	 Cat
	 2.	 Sprite is an object which performs functions controlled by scripts.
	 3.	 The Stage

Activity : Do it yourself

Exercise
A.	 1.	 (b) program	2.	 (b) project	 3. (c) Title bar	 4.	 (b) Green flag
B.	 1.	 Scratch	 2.	 Block palette			  3.	 Stop
	 4.	 Sprite	 5.	 Title bar
C.	 1.	 T	 2.	 T	 3.	 F	 4.	 T	 5.	 T

D.	 1.	 (a) A way to run the script	 2.	 (c) Stops all the scripts
	 3.	 (e) Moves sprite 10 steps backward
	 4.	 (b) Points sprite in the specified direction
	 5.	 (d) Moves sprite 20 steps forward.
E.	 1.	 A program is a sequence of instructions given to a computer.
	 2.	 Scratch is an activity which you use to give instructions that the  

		 computer understand
	 3.	 Motion Block controls the movement of sprites (up, down, left,  

		 right, rotation, etc.).
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	 4.	 Motion Block controls the movement of sprites (up, down, left,  
		 right, rotation, etc.).

	 5.	 Pen Block allows the user to draw lines and objects on the stage.

Activity : Do it yourself	        Project Work : Do it yourself

Chapter - 5 
Warm up
	 1.	 Line tool	 2.	 Save tool	 3.	 Brick Effect

Exercise
A.	 1.	 (a) Save tool		  2.	 (b) Open tool	 3.	 (a) Line tool

	 4.	 (a) Paint tool		  5.	 (a) Pattern tool

B.	 1.	 Paint	 2. Hazebrush	 3. Thumbnail	 4. Mirror
	 5.	 ABC Text
C.	 1.	 (e) ABC Text tool     2.  (a) Pattern tool	 3.	 (b) Rainbow tool
	 4.	 (c) Open tool		  5.	 (d) Magic tool
D.	 1.	 Text Paint	 2.	 Text tool	 3.	 Mirror effect
	 4.	 Stamp tool	 5.	 HazeBrush tool
E.	 1.	 Stamp tool	 2.	 Magic tool	 3.	 Hazebrush tool
	 4.	 Line tool	 5.	 Paint tool
F.1.	 a.	 Paint tool	 b. Shape tool	     c. Save tool
2.	 The images are saved in the form of thumbnail in TuxPaint.
3.	 The Sub Toolbox has options of Brush, Shapes and Special Effects.
4.	 Features are:  a.   It can be downloaded and used free of cost.
	 b.	 One may even add a stamp once through the drawing.
	 c.	 The images are saved directly as thumbnails.
5.	 Hazebrush tool is basically used to draw things that are far off.
6.	 Magic tool allows you to give amazing effects to the pictures.

Activity : Do it yourself	     Project Work : Do it yourself

Chapter - 6
Warm up
	 1.	 World Wide Web
	 2.	 Internet helps to search information
	 3.	 Website

Exercise
A.	 1.	 (a) Internet		  2.	 (a) Water bottle
	 3.	 (c) Online games	 4.	 (a) Writer
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B.	 1.	 (d) Is the network of computers across the world.
	 2.	 (b) Is the longest collection of information on internet.
	 3.	 (a) lets you view different websites.
	 4.	 (c) Is an electronic page of a website.
C.	 1.	 Modem	 2. Browser	 3. Website	 4. Network
D.1.	The full form of WWW is World Wide Web.
2.	 Internet is a network of the interlinked computer networking 

worldwide.
3.	 Website is a collection of related webpages that provide information.
4.	 It is a software application for accessing information on the world 

wide web. The website we open in a special software known as 
browser.

Activity Zone
A.	 Microsoft Edge		    Mozilla Firefox	 Google Chrome
B.	 Do it yourself			   C.	 Do it yourself

Project Work : Do it yourself

Chapter - 7
Warm Up
1.	 George Mills		  2.    Language of Graphics Oriented

Activity
1.	 Forward 40
	 Step 1:	 Type FORWARD	 Step 2:	 Press the Spacebar
	 Step 3:	 Type 40			  Step 4:	 Press Enter
2.	 Right 90
	 Step 1:	 RT90			   Step 2:	 Press Enter key
3.	 BACK 60
	 Step 1:	 BK60			   Step 2:	 Press Enter Key
4.	 Left 90
	 Step 1:	 LT90			   Step 2:	 Press Enter Key

Exercise
A.	 1.	 (b) Language of Graphics Oriented
	 2.	 (a) MSW-LOGO		 3.	 (c) Turtle	 4.	 (a) Centre
	 5.	 (c) Turtle
B.	 1.	 (e) Turtle	 2.	 (a) Language of Graphics Oriented
	 3.	 (b) Graphic screen	 4.	 (d) Top of the Turtle
	 5.	 End of the Turtle
C.	 1.	 LOGO	 2.	 Debugging
	 3.	 Forward, backward, left and right
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D.1.	It helps to find any mistake we might have made in giving commands 
to the MSW-LOGO.

2.	 It pauses MSW-LOGO temporarily and waits for the continue 
command.

3.	 It halts the MSW-LOGO from executing a command.
4.	 Once you have written the command in the input box, you click on 

EXECUTE button.
E. 1.	Language of Graphics Oriented
2.	 Commands given in MSW LOGO are called Primitives.
3.	 MSW-LOGO is used to draw simple shapes, write and do  

	calculations.
4.	 Input box is the area where the LOGO commands are typed.
		 Command tools and controls are used to play, pause and reset the  

	turtle.
5.	 The steps are:
		 a.	 Click on start button.
	 b.	 Click All apps and then Windows Accessories.
	 c.	 Click on Microsoft Windows LOGO
	 d.	 Now, Click on Microsoft Window LOGO option. MSW-LOGO  

		 screen appears.

Activity
	 Title Bar, Menu Bar, Main Screen, Commander Window, Scroll Bar, 

LOGO’s turtle.

Project Work : Do it yourself

Chapter - 8
Warm Up
	 1.	 Language of Graphics Oriented
	 2.	 Backward			   3.	 Forward

Exercise
A.	 1.	 (c) Commands		  2.	 (a) RT	 3. (a) LEFT
	 4.	 (b) FORWARD		  5.	 (b) HOME
B.	 1.	 FD	 2.	 (a) CT	 3.	 (b) CLEAN
	 4.	 BYE	 5.	 HT
C.	 1.	 FD	 2.	 Recall list box	 3.	 Input box
	 4.	 CT	 5.	 RT
D.1.	It makes the turtle come to its default position, that is, the centre of 

the screen.
2.	 It makes the turtle appear again giving the ST command.
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3.	 It clears the whole graphic window without changing the position of 
the turtle.

4.	 It makes the turtle move backward by giving BK command to the 
turtle.

5.	 It rotates the head of the turtle to its right by giving RT command.
E.1.	 It clears the graphic screen and the turtle moves back to its HOME 

position.
2.	 This will make the turtle move just 60 steps in the direction of his 

head.
3.	 It makes the turtle come to its default position, that is, the centre of 

the screen.
4.	 ClearScreen command clears the graphic screen and the turtle moves 

back to Home position. Clear command clears the graphic window 
without changing the position of the turtle.

5.	 We can enter commands in the Input box.

Activity Zone
A. C E S T A M P N I Y

O C E R A S E R A H

M H A P E R O Q H C

M H N S A V E I E V

A T U R T L E Y A P

N F B R U S H Q D E

D T A I L O X G T E

E U G S N Q B G Y B

R I N P U T O G I C

X A P Z P G X O Y A

B.	 Do it yourself

Project Work : Do it yourself

Model Test Paper-1
A.	 1.	 (c) MS-Window		 2.	 (a) Right
	 3.	 (c) Ctrl + S			   4.	 (c) Title bar
B.	 1.	 Printer	 2.	 Icons	 3.	 Ctrl + S	 4.	 Sprite
C.	 1.	 T	 2.	 F	 3.	 T	 4.	 F
D.1.	Software refers to the programs. It helps in the functioning of a 

computer. We cannot see and touch software. There are two types of 
software Application and System Software.
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2.	 We can change by following some steps:
	 a.	 Right-click on the blank area of a desktop.
	 b.	 From the shortcut menu, click on the personlize option.
	 c.	 A new window will open, click on the screen saver option.
	 d.	 Go to the screen saver option for selecting the desired screen saver  

		 and click on drop down arrow.
	 e.	 A preview will be displayed.
3.	 Creating documents on computer is called word processing.
4.	 Motion Block, Sound Block, PEN Block, Control Block

Model Test Paper-2
A.	 1.	 (a) Save tool			  2.	 (a) Internet
	 3.	 (c) Turtle			   4.	 Home
B.	 1.	 Point	 2.	 LOGO	 3.	 debugging	 4.	 Input box
C.	 1.	 (c) Turtle	 2.	 (a) Language of Graphics Oriented
	 3.	 (b) Graphic Screen	 4.	 (d) Top of the Turtle
	 5.	 (c) End of the turtle
D.1.	The sub toolbox has options of Brush, Shapes and Special Effects.
2.	 A website is a collection of related webpages that provide information.
3.	 It is the area where the LOGO commands are typed.
4.	 We enter the commands in Input box.

National Cyber Olympiad (Sample Paper)
Logical Reasoning
	 1.	 (C) 			   2.	 (C) Resize
	 3.	 (D)			   4.	 (A) VDU
	 5.	 (C) Drawing purposes

Computer and Information Technology
	 6.	 (B)
	 7.	 (B)
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Techno Clone - 4
Chapter - 1 

Warm up
1.	 Charles Babbage	        2.	 Charles Babbage
3.	 On Abacus calculations are done quickly by moving the beads on the 

rack.

Activity 1
	 (i)	 Abacus	 (ii)	Slide Rule	 (iii)   Tabulating Machine
	 (iv)  Napier Bones

Activity 2
	 (i)	 Smart phone	   (ii)  PDA      (iii)  Tablet     (iv)  Desktop Computer

Exercise
A.	 1.	 (c) Napier Bones	 2.	 (c) Charles Babbage
	 3.	 (a) 1614	 4.	 (c) Blaise Pascal	   5.   (c) Super-Computers
B.	 1.	 Abacus	 2.	 Charles Babage		  3.	 Herman Hollerith
	 4.	 Analog	 5.	 Digital
C.	 1.	 T	 2. F		 3. T	 4. T	 5.	 F
D.	 1.	 Universal Automatic Computer
	 2.	 Electronic Discrete Variable Automatic Calculator
	 3.	 Atanasoff-Berry Computer
	 4.	 Electronic Numerical Integrator And Calculator
	 5.	 Personal Digital Assistant
E.1.	 Abacus was the first calculating device developed by the Chinese and 

Egyptians.
2.	 It is a calculating device to speed up the multiplication process. It is a 

very good calculating device which calculates very fast.
3.	 Analog computers are those computers in which data or number is 

represented in the form of continuously varying physical quantities 
such as pressure, temperature, voltage current, etc. Digital computers 
are the computers that solve problems by operating on discrete data 
representing variables by performing arithmetic and logical processes 
on data from a stored program.

4.	 Different types of digital computer are: Special and general purpose 
computer, embedded and Micro-computers.

5.	 Super computers are designed to be used for extremely complicated 
computations, that also in minimum possible time. They are the 
fastest, the largest and most expensive digital computers available 
today. They are best used in nuclear science, weather forecasting, 
aerodynamic modeling, etc. The 5 popular supercomputers are: 
Jaguar, Kraken, Nebulae, Jugene, road Runner.
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Activity Zone
Across	
	 2	 ABACUS	 5	 IBM	 6	 PASCALINE
Down
	 1	 ENIAC	 7	 ABC	 3	 UNIVAC	    4	   LEIBNIZ
Project Work
Napier Bones	 Pascaline	 EDVAC	 Abacus	 UNIVAC

Chapter - 2 
Warm Up
	 1.	 Monitor	 2.	 Keyboard		 3.   Central Processing Unit
Activity

Input Devices Output Devices

Light Pen, Keyboard, Barcode 
Reader, Joystick, Webcam

Plotter, Speakers, Monitor, Dot-
matrix printer, Laser Printer

Exercise
A.	 1.	 (b) CPU	 2.	 (c) Both a and b	  3.  (b) Cathode Ray Tube
	 4.	 (c) Laser Printer		 5.	 (c) Both a and b
B.	 1.	 CPU	 2.	 output	 3. 	 Mechanical
	 4.	 Light pen	 5.	 barcode reader
C.	 1.	 F	 2. T		  3. T	 4. T	 5. T
D.1.	It displays computer output. 
2.	 It is used for entering data and information into the computer.
3.	 It is used to input data into the computer in the form of pictures.
4.	 They are used to hear various sounds meant to alert the user, as well 

as music and spoken text.
E.1.	 Computer works by taking input, processing it and giving output. 

This is known as IPO cycle.
2.	 An input device is used to receive data or instructions from the user. 

Example keyboard, mouse etc. An output device is used to display 
the results of processing. Example Printer, speaker, etc.

3.	 Mouse could be mechanical, optical or cordless types. These types are 
as follows:

	 a.	 Mechanical mouse- It uses ball for the movement of cursor on the  
		 computer screen.

	 b.	 Optical mouse - It uses laser rays for the movement of cursor on  
		 the computer screen.

	 c.	 Cordless mouse - It is battery driven and does not need any wire  
		 for the physical connection with the CPU.

4.	 Dot matrix Printer - It prints the images and text in a form of tiny 
dots. This printer can print only in black and white. 

	 Inkjet Printer - It operates by propelling variably-sized droplets of 
liquid or molten material onto almost any sized page.
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Inpact Printer
		  Advantages				   Disadvantages 
	 a.	 Less expensive		  a.	 Noisy
	 b.	 Can make multiple copies	 b.	 Slow
	 c.	 Durability			   c.	 Print low quality sometime

Activity Zone
Input Device Output Device Storage Device Processing Device

Mouse Monitor DVD CPU
Keyboard Printer Pen Drive Desktop processor
Scanner Speakers
Joystick Hard Disk
Barcode Reader
Microphone

Project Work : Do it yourself

Chapter - 3 
Warm Up
	 1.	 The taskbar is a long horizontal bar at the bottom of the desktop.
	 2.	 Double-click opens the selected item.
	 3.	 Icon is a small graphical representation of a program or file.

Activity
	 Icons, Taskbar, Start Button, Desktop, Notification Area
Exercise
A.	 1.	 (c) CPU	 2.	 (b) Folder	 3.	 (a) Aero Peek	     4.   (c) Files
	 5.	 (a) Windows Explorer	 6.	 (a) Tool	 7.	 (a) Desktop
B.	 1.	 Windows 10			  2.	 Icons	 3. Operating system
	 4.	 Start menu	 5.	 File	 6.	 Left pane
C.	 1.	 T	 2. T	 3. T	 4. T	 5. T	      6.  F
D.1.	a.	 It allows us to reach more destination in much less time by  

		 browsing fastly and booting time is much short.
	 b.	 It allows you to turn the opened windows transparent and make  

		 the desktop visible.
2.	 The screen that appears after switching on a computer is called 

desktop.
3.	 It mean to change the name of file and folder
	 a.	 Right-click on the file/folder that has to be renamed and select the  

		 Rename option.
	 b.	 Type the new name in the highlighted area.
	 c.	 Press Enter key and the new name will be saved.
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4.	 By following some steps:
	 a.	 Right-click on the desktop and select Personalize option from the  

		 context menu.
	 b.	 Click on Windows Color. A new Window of Window Color and  

		 Appearance will open.
	 c.	 Choose the Colour Scheme.
	 d.	 Click on the Save Changes button.
5.	 It is a handy tool to manage our files and folder in a computer.
6.	 Window Explorer screen is divided into 2 parts:
	 a.	 The Left part (Left pane)
	 b.	 The right part (Right pane)

Activity Zone
A. File Folder

A file is collection of related 
information stored together in a 
storage device.

Folder is like a cabinet which 
contains a group of files or sub 
folders.

B.	 1.	 FILE	 2.	 WINDOW	 3.	 EXPLORER	
	 4.	 MENU	 5.	 FOLDER	 6.	 TASKBAR

Project Work
Across
	 1.	 START	 3.	 TUX	 4.	 TASKBAR	
	 7.	 WALLPAPER		  8.	 ICONS	 9.	 DESKTOP
Below
	 2.	 THUMBNAIL	 5. FILE     6.	 FOLDER	 7.	 WINDOW

Chapter - 4 
Warm up
	 1.	 Menu Bar, Title Bar
	 2.	 You can create a new blank document by clicking File then 

click new or you can also press Ctrl + N for opening new blank 
document.

	 3.	 Ctrl + P

Activity : Do it yourself
Exercise
A.	 1.	 (a) Undo	 2.	 (a) red wavy line	 3.	 (b) Thesaurus
	 4.	 (b) beautiful			  5.	 (b) Vertical
B.	 1.	 document	 2.	 redo	 3.	 green	 4.	 Formatting
	 5.	 font
C.	 1.	 T	 2.	 T	 3.	 F	 4.	 T	 5.	 T
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D.1.		The steps are:
	 a.   Type: “Hi there”.
	 b.	 Click on Undo in the Quick Access Toolbar
	 c.	 The typing would disappear.
	 d.	 Click on Redo.
	 e.	 The typing would reappear.
2.	 Formatting means to change the appearance of our document.
3.	 Thesaurus is a feature that enables you to proofread or edit the 

documents.
4.	 A font is a set of printable of displayable text characters in a special 

style and size.
	 The steps to change font size are:
	 a.	 Select the text to change the font size.
	 b.	 Click on the drop-down arrow of font size option in font group of  

		 Home tab.
5.	 Line spacing changes the vertical distance between the lines of text in 

a document. We can change it by some steps:
	 a.	 Select the text.
	 b.	 Click on the down arrow of line spacing option from the Paragraph  

		 group in Home tab.
	 c.	 Select the line spacing value you want to apply. The line spacing  

		 will change.

Activity Zone
A.	 1.	 D E L E T E	 2.  C O P Y  /  P A S T E
	 3.	 C U T		  4. R E D O
B.	 1.	 (d) underline		  2.	 (e) Font colour
	 3.	 (a) Italics	 4.	 (c) Bold	 5.	 (b) Highlighting

Project Work : Do it yourself

Chapter - 5 
Warm up
	 1.	 Scratch
	 2.	 The block palette is where the different script blocks are located.
	 3.	 The elements are Script, Area, Sprite.

Exercise
A.	 1.	 (b) Software		  2.	 (a) Cat Sprite	 3.	 (b) below
	 4.	 (b) three			   5.	 (c) 	 6.	 (b)
B.	 1.	 Scratch	 2.	 Sprite	 3.	 Sound	 4.	 Look	 5.	 Costume
	 1.	 T	 2.	 F	 3.	 F	 4.	 T	 5.	 F
D.1.	A Scratch is a multimedia programming language used to create 

interactive stories, games, animation, music and art by dragging and 
dropping of instructions.
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2.	 The language used to write the instructions is called a programming 
language.

3.	 The sprite list displays thumbnails for all sprites in a project.
4.	 There are three tabs that are Script tab, Costume tab, Sound tab.
5.	 The ways to create a new costume are:
	 a.	 Click Paint button to paint, new costume using Paint Editor.
	 b.	 Click Import button to select a costume from the file.
	 c.	 Click camera button to take photos from the web camera.

Activity : Do it yourself

Chapter - 6
Warm up
	 1.	 Bill Kendrick	 2.   Text Tool		 3.   True
Exercise
A.	 1.	 (b) 3 to 12	 2.	 (b) Shape tool		  3.	 (b) Eraser tool
	 4.	 (c) Both	 5.	 (c) Alt + F4
B.	 1.  mascot    2.  360°    3.   Drip magic    4.   Eraser     5. open dialog box
C.	 1.	 T	 2.	 F	 3.	 T	 4.	 F	 5.	 F
D.1.	Tux Paint is a free and open source graphics editor designed specially 

for the children.
2.	 Drip magic tool gives a dripping effect to our drawing. It is used to 

Scatter color or ink in our drawing.
3.	 The steps are:    a.	 Click on open button from toolbar.
	 b.	 Click on desired drawing.
	 c.	 Click on open button. Selected drawing appears.
4.	 The steps are:    a.	 Open the file with sky blue background.
	 b.	 Select the Magic tool from the tool box and Rainbow effect from  

		 the sub toolbox.
	 c.	 Now, place your wand anywhere in the drawing area and drag  

		 it to some other point you will see a train of rainbow colour as you  
		 draw.

	 d.	 Now, select the real rainbow effect.
	 e.	 Choose a single point on the drawing area from that point. Click  

		 and drag the mouse to a new location.
	 f.	 You will see a rough sketch of the rainbow as you drag your box.
	 h.	 As you reach the end point, release the left mouse button and you  

		 will see Real Rainbow on your screen.
5.	 We can exit Tux Paint by using Quit button.

Activity Zone
A.	 1. (d)	 2. (e)	 3. (f)	 4. (a)	 5. (c)	 6.  (b)
B.	 Do it yourself

Project Work : Do it yourself
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Chapter - 7
Warm Up
1.	 A presentation is a collection of slides arranged in sequential order 

which can be used to teach, provide information, entertainment, etc.
2.	 Yes		  3.      True

Exercise
A.	 1.	 (b) presentation	 2.	 (a) Save As dialog box
	 3.	 (a) Macintosh		 4.	 (b) PowerPoint
B.	 1.	 Sound, animation, video	 2.	 Slide	 3.	 File Tab button
	 4.	 Title
C.	 1.	 F	 2.	 T	 3.	 T	 4.	 T	 5.	 T
D.1.	Slide is the current page that is displayed on the window. It is like a 

page of book that contains information about a topic.
2.	 Ctrl + M to add a new slide.
3.	 The presentation will be saved with PowerPoint extension .pptx.
4.	 ESC key is used to exit the slide show.
5.	 The stages are:
	 Stage 1: Plan – Decide an outline for the presentation.
	 Stage 2: Execute – Create the slides.
	 Stage 3: Impress – verify content, add visual effects and practice.
	 Stage 1: Deciding an outline for the presentation.
	 a.	 Gather information for the given topic and choose an appropriate  

title for the presentation.
	 b.	 Go through the information that you have collected. Group related 

information and list the main points you want to present.
	 c.	 For each main point, list its sub-points.
	 Stage 2: Execute – Creating the slides Microsoft PowerPoint 2016 

is a presentation program of Microsoft Office suite. It creates 
presentation. There are number of pages in a presentation. An 
individual page is called a slide.

6.	 The three steps are:
	 a.	 Content Review: Carefully go through each slide to ensure all 

information is accurate, relevant and presented clearly. Check for 
spelling and grammar errors.

	 b.	 Design and Layout Check: Verify that the design elements such 
as fonts, colors, and slide layouts are consistent and visually 
appealing. Ensure that layout facilitates understanding.

	 c.	 Functionality Testing: Test any animations, trasitions, multimedia 
elements and hyperlinks to ensure they work smoothly and 
enhance the presentation’s delivery without causing distractions.

7.	 The benefit of using Word Art is that it creates visually appealing text 
with various styles, fonts, colors and effects. It highlights headings, 
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titles, etc. It gives a creative way to express ideas and concepts and 
provides a customized text according to the theme. It can also be 
manipulated, resized according to slide.

	 Steps to insert Word Art are:
	 a.	 Click on the insert tab on the Ribbon.
	 b.	 Click Word Art from text group. A gallery appears with different  

		 Word Art Styles.
	 c.	 Select the style of your choice.
	 d.	 Replace the text in the text box with your text and click outside it.
8.	 We can start a slide show by pressing F5 function key.

Activity Zone : Do it yourself
Project Work
	 1.	 Ctrl + S		 2.     Ctrl + O		  3.  Ctrl + M

Chapter - 8
Warm Up
1.	 It is an electronic mail sent to anyone around the world.
2.	 Internet is a technology through which millions of computers around 

the world get connected together to share information by the means 
of cable or wireless media of communication.

3.	 False

Exercise
A.	 1.	 (a) Computers		  2.	 (c) access	 3. (b) E-mail
	 4.	 (b) Website			   5.	 (b) Refresh
B.	 1.	 Internet	 2.	 Webpage	 3.	 URL	 4.	 link     5.  underlined
C.	 1.	 F	 2.	 T	 3.	 T	 4.	 F	 5.	 T
D.1.	It is a document created and stored in an electronic form.
2.	 It is a collection of webpages which provides information about 

organization, person, etc.
3.	 First page is the main page of the site which is called the Home page.
4.	 Hyperlink is a mechanism by which Web page is linked to another 

related web page.
5.	 It searches the various web pages on the world wide web.
E.1.	 A network is a collection of computers and devices interconnected to 

one another.
2.	 Internet is a technology through which millions of computers around 

the world get connected together to share information by the means 
of cable or wireless media of communication.

3.	 World Wide Web. It is a collection of web pages found on this network 
of computers. It helps us to access different sites on Internet.

4.	 Web browser is a program which lets us access the web pages.
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5.	 The things required for Internet are:
	 •	 A Computer
	 •	 A modem and telephone line
	 •	 An Internet Browser to connect you to the ISP
	 •	 An account with Internet Service Provider (ISP)
6.	 It is an electronic mail sent to anyone around the world.
7.	 Popular search engines are Internet Explorer, Chrome and Mozilla 

Firefox.

Activity Zone
A.	 1.	 Microsoft Edge	    2.  Mozilla Firefox	 2.	 Google Chrome
B.	 Do it yourself

Project Work
1.	 Internet is used for searching information.
2.	 It is used to send or receive text, graphics, sound and videos anytime 

and anywhere.
3.	 We can download songs, movies, games, etc through Internet.
4.	 Online education can be done through e-learning websites.
5.	 On Internet, anybody can now buy and sell things.

Model Test Paper-1
A.	 1.	 (c) Napier Bones	 2.	 (b) Printer
	 3.	 (a) Files	 4.	 (b) beautiful		  5.  (b) Vertical
B.	 1.	 Abacus	 2.	 CPU	 3.	 Icon	 4.	 documents	 5.  Redo
C.	 1.	 T	 2.	 T	 3.	 T	 4.	 T	 5.	 T

Model Test Paper-3
A.	 1.	 (a) Cat sprite		  2.	 (b) 3 to 12
	 3.	 (c) Alt + F4			   4.	 (a) Macintosh
	 5.	 (a) Computers
B.	 1.	 Scratch	 2.	 Drip Magic	 3.	 Open dialog box
	 4.	 Home page			   5.	 Internet
C.	 1.	 F	 2.	 T	 3.	 F	 4.	 T	 5.	 F

National Cyber Olympiad (Sample Paper)
Logical Reasoning
	 1.	 (a) 125			   2.	 (b) 
	 3.	 (c)  POEAR			   4.	 (d) All of these
	 5.	 (a) Aero Peek		  6.	 (b) Input device
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Techno Clone - 5
Chapter - 1 

Warm up
	 1.	 Abacus	 2.	 Charles Babbage	 3.	 Charles Babbage

Activity 1
	 1.	 DESKTOP	 2.	 LAPTOP		           3.   PALMTOP
	 4. 	 SERVER	 5.	 MAINFRAME	          6.   SUPERCOMPUTER

Activity 2
	 1.	 (b) Vacuum tubes    2.   (c) Transistors	 3.	 (a) ICs
	 4.	 (d) Powerful servers	 5.	 (e) Portable Memory Device

Exercise
A.	 1.	 (b) 1940-1956		  2.	 (a) Transistors
	 3.	 ICs (Integrated circuit)	 4.	 (a) ENIAC	 5.	 (b) PARAM
B.	 1.	 Transistors   2.  Fourth	 3.	 Palmtop	 4.	 first	 5.	 second
C.	 1.	 T	 2. F		 3. F	 4. F
D.	 1.	 (d) Transistors		  2.	 (a) Integrated Circuits
	 3.	 (c) Microprocessor	 4.	 (b) Artificial Intelligence
E.1.	 Two features are:
	 a.	 They were faster, smaller and reliable than previous generation.
	 b.	 They used high-level programming languages such as FORTRAN 

and COBOL.
2.	 The characteristics are:     a.	They were easier to update.
	 b.	 They were faster, smaller, reliable and cheaper.
3.	 Second generation of computers had more computing power, were 

smaller in size, easier to maintain and were more affordable than the 
previous generation where vacuum tubes were used.

4.	 Server is a powerful version of desktop capable of catering to various 
applications in a network environmemnt.

5.	 Supercomputer has multiprocessor to perform typing scientific 
applications that need trillions of input per second while processing.

Activity Zone : Do it yourself	 Project work : Do it yourself

Chapter - 2 
Warm Up
1.  Windows,  linux	   2.  Adobe Photoshop, MS Excel	 3.	 True

Activity
	 1.	 LINUX	 2.	 WINDOW	 3.	 MS WORD	
	 4.	 MS EXCEL	 5.	 PHOTOSHOP	    6. ILLUSTRATOR
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Exercise
A.	 1.	 (a) Software			   2.	 (b) Basic Input Output System	
	 3.	 (c) Both a and b	       4.  (b) MS EXCEL	 5.	 (a) MS Word
B.	 1.	 program	 2.	 motherboard		  3. 	Operating
	 4.	 defragmentation	 5.	 backup
C.	 1.	 T	 2.	 T	 3.	 T	 4.	 F	 5.	 T
D.1.	A set of instructions, data or programs used to operate computers 

and execute specific taskes.
2.	 BIOS stands for Basic Input Output System. It starts or boots the 

computer. It checks whether all the hardware units are working. It 
loads the operating system.

3.	 The operating system is responsible for managing the computer’s 
hardware and software resources. Its functions are it controls the 
memory needed for computer processes, manages disk space, 
controls peripheral devices and manages user communication with 
the computer.

4.	 Difference between System Software and Application Software

System Software Application Software

(a) They are mainly designed 
for managing system 
resources.

(a) They are designed to accomplish 
tasks for specific purposes.

(b) A computer cannot run 
without system software.

(b) A computer can easily run 
without application software.

(c) Programming of system 
software is complex.

(c) Programming of application 
software is comparitively easy.

(d) Examples– Window, MAC (d) Example – MS PAINT, Adobe 
Photoshop

5.	 It is essential to have a backup file because if original file is damaged, 
corrupt or lost then backup file will help.

6.	 Defragmentation picks up all the pieces of data that are spread 
accross your hard drive and puts them back together again. It is like 
a cleaning house for our computer.

Activity Zone
	 1.	 MS PAINT			   2.	 LINUX

Project work : Do it yourself

Chapter - 3 
Warm Up
	 1.	 Memory Card is used to store information.
	 2.	 Primary memory is the memory that can be accessed directly by 

the CPU.			   3.	 Compact Disc
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Activity
	 1.	 (e) CD-ROM			  2.	 (c) RAM
	 3.	 (b) hard disk		         4.  (d) ROM		 5.	 (a) Flash drive

Exercise
A.	 1.	 (a) two digits	 2. (b) 8 bits	 3.	 (b) Random Access Memory
	 4.   (a) RAM			   5.	 (b) external memory
B.	 1.	 data    2.   Information    3. Kilobyte   4.  ROM	 5.  USB
C.	 1.	 T	 2.	 F	 3.	 T	 4.	 T	 5.	 T
D.1.	A byte is the smallest group of information that a computer can 

process.
2.	 1024 bytes are equal to one Kilobyte. It is equal to one page of the text 

book.
3.	 1,048,576 bytes (1024 KB) are equal to one Megabyte. It is 

approximately equal to one book.
4.	 1024 MB is equal to one Gigabyte. It is approximately equal to a pile 

of books.
5.	 1024 GB is equal to one Terabyte. It is approximately equal to an 

entire book stand.
E.1.	 It applies to any electronic component in a computer system that is 

capable of storing data.

2. Volatile Memory Non-Volatile Memory

a. It is a temporary memory. a. It is a permanent memory.

b. It stands for RAM  
(Random Access Memory)

b. It stands for ROM  
(Read-Only Memory)

c. Data stored on it can be 
changed.

c. Data stored on it can be read 
but cannot be changed.

d. It loses all the content when 
computer is turned OFF.

d. It does not lose the content 
when computer is turned 
OFF.

3.	 Primary memory is the memory that can be accessed directly by the 
CPU. It is internal memory.

	 It has two types: 
	 (a)	RAM (Random Access Memory)
	 (b)	ROM (Read Only Memory)
	 (a)	RAM is a temporary memory.
	 (b)	ROM is a permanent memory.
4.	 The various types of secondary memory are:
	 a.	 Magnetic Tape : It is used for storing data backups. The average 

amount of storage is 5 MB to 140 MB.



Techno Clone — (39)

	 b.	 Hard Disk : It is installed inside the computer. It has large storage 
capacity. It is a magnetic disk, on which the data is stored. It comes 
with 1 TB or more. By default all the work of computer stores in 
the hard disk. Hard disk is partitioned into drives such as C:, D:, 
E: drive etc.

	 c.	 CD-ROM : It stands for Compact Disk-Read only memory.
		  It is portable and can store large data. It has a storage capacity of 

700 MB.
	 d.	 DVD-ROM : It is a type of recordable DVD has a storage capacity 

of 4.1 GB. There is also an 8.54 GB dual-layer version, called 
DVD-R DL.

5.	 Magnetic Tape is used for storing data backup.

Activity Zone
	 1.	 DVD	 2.	 CD-ROM	 3.	 Pen drive	 4.	 Hard Disk

Project work : Do it yourself	

Chapter - 4 
Warm up
1.   False      2.    Window     3.  Windows XP, Window 7 and Window 8

Activity
	 1.	 (d) Desktop	      2. (c) Icon	 3.	 (e) Recycle Bin
	 4.	 (b) Control Panel	 5.	 (a) Start button

Exercise
A	 1.	 (c) Window 10		  2.	 (b) Wallpaper
	 3.	 (a) Icons	 4.   (a) taskbar	 5.	 (b) title bar
B.	 1.	 Desktop	 2.	 Recycle bin	 3.  Selected	 4.  Menu	 5.	 File
C.	 1.	 F	 2.	 T	 3.	 T	 4.	 T	 5.	 F

D.1.		When we click on our user-id and enter our password, we see the 
main screen of windows, called desktop. Wallpaper, Icons, Taskbar 
are the things which we see mainly on desktop.

2.	 Icons are small graphics or pictures on the desktop with names such 
as computer document, Recycle Bin, Internet Explorer, etc.

3.	 A file is a collection of data stored together. A folder is like a bag that 
stores a group of files and/or other folders or subfolders.

4.	 The steps are:
	 a.	 Select an icon.
	 b.	 Double-click on it. Icon will be opened.
5.	 The steps are:
	 a.	 Click once on the selected icon.
	 b.	 Now it is deselected.
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6. Window XP Window 10
a. These processes are slow in 

Windows XP.
a. These processes are very fast 

in Windows 10.
b. There are not many 

graphical components in 
Windows XP.

b. Windows 10 has lots of 
graphical components and is 
more attractive.

c. It is necessary to install 
drivers in Windows XP.

c. There is no need to install 
drivers in Windows 10.

d. Window XP is not reliable 
as Windows 10.

d. Windows 10 is very reliable.

e. Windows XP is not secure 
as Windows 10.

e. Windows 10 is very secure 
than Windows XP.

Activity Zone
Across
	 1.	 S T A R T	 3.	 F I L E	 4.	 T A S K B A R
	 7.	 W A L L P A P E R       8. I C O N S	 9.	 D E S K T O P
Down
	 2.	 T I T L E	 5.	 F I L E      6.  F O L D E R	 7.   W I N D O W

Project work : Do it yourself

Chapter - 5 
Warm up
	 1.	 We make a computer work by giving a set of instructions called a 

program.
	 2.	 Operating System	 3.	 Wallpaper, Icons

Exercise
A.	 1.	 (b) the user and the hardware

	 2.	 (c) viewing deleted files and folders

	 3.	 (a) Start Menu		 4.	 (b) theme

B.	 1.	 Operating system	 2.	 Control panel
	 3.	 Screen Saver			  4.	 large
C.	 1.	 T	 2.	 F	 3.	 T	 4.	 F
D.1.	Operating System is the most basic software present on a computer 

system.
2.	 The task customising of computer can be done by using the Contral 

Panel. It can be open from the start menu.
3.	 Theme is a combination of pictures, colours and sound on the 

computer. It includes desktop background, window border colour, a 
sound scheme and a screen saver.
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4.	 The screen resolution determines the amount of information you 
can view on the computer screen at any given time. A higher screen 
resolution makes everything appear small on the screen. A lower 
screen resolution makes everything appear large.

5.	 The steps are:
	 a.	 Click on the Adjust screen resolution link under the Appearance 

and Personalization section in the Control Panel window. This 
displays the sceen resolution window.

	 b.	 Click on the drop-down arrow next to resolution.
	 c.	 Move the slider to the resolution you want.
	 d.	 Click on the OK or Apply button. The screen resolution Changes 

accordingly and a Display Settings dialog box appears.
	 e.	 Click on keep changes to use the new resolution or click Revert to 

go back to the previous resolution.
6.	 The option to change the date and time settings can be accessed by 

choosing the clock, language, and Region link in the control Panel 
Window.

Activity Zone : Do it yourself

Project Work
	 Step 1: Click Start			   Step 2: Click Settings
	 Step 3: Click Personalization	 Step 4: Click Themes
	 Step 5: Then click ‘Change theme’
	 Step 6: Now click the tile to switch to the theme you’d like to use.

Chapter - 6
Warm up
	 1.	 Ctrl + S		  2.     True		  3.    Alt + F4

Activity 1
	 1.	 (c) Changing the colour of the text
	 2.	 (d) Changing the width, line style and outline colour of the text.
	 3.	 (b) Applying a visual effect to the text.
	 4.	 (a) Changing the existing style of the text.

Activity 2
	 1.	 SENTENCE CASE	 2.	 LOWER CASE
	 3.	 FOOTNOTE			  4.	 WORDART

Exercise
A.	 1.	 (b)       2. (c) 	 3.   (b) Format     4.    (b) end        5.  (b) Lower case
B.	 1.	 Picture	 2.	 Clip Art	 3.	 Word Art
	 4.	 Text fill	 5.	 Header, Footer
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C.	 1.	 T	 2.	 F	 3.	 T	 4.	 F
D.1.	Clip Art is a gallery of ready-made pictures that can be inserted 

directly in the document.
2.	 To resize the picture, click and drag any of the circles at the corners 

of the picture inward and outward. To stretch the picture, click and 
drag any of the squares at the centre of the each side of the picture 
inward or outward.

3.	 Cropping means to cut off a part of the picture.
4.	 a.	 Step 1:	 Click the Insert tab on the Ribbon
		  Step 2:	 Click WordArt from the Text group. The Word Art gallery 

appears.
		  Step 3:	 Select the style of your choice. A box appears with your 

text here’ written inside the selected style.
		  Step 4:	 Press Delete key and type the text.
	 b.	 Step 1:	 Place the cursor where you want to insert the symbol.
		  Step 2:	 Click the Insert tab.
		  Step 3:	 Click symbol from the Symbols group. A list of symbols 

appears.
		  Step 4:	 Select the symbol you require.
	 c.	 Step 1:	 Double-click on the shape to select it. The format tab 

opens.
		  Step 2:	 Click Shape Fill from the Shape Styles group. A colour 

palette appears.
		  Step 3:	 Choose any colour from the colour palette. The shape 

gets filled with that colour.
	 d.	 Step 1:	 Click the Insert tab.
		  Step 2:	 Click Header from the Header & Footer group. A gallery 

appears.
		  Step 3:	 Choose the style of your choice.
		  Step 4:	 Now, type the text you want at the top of each page.
		  Step 5:	 Now, click Close Header and Footer from the close group 

of Design tab.
	 e.	 Step 1:	 Click the Insert tab.
		  Step 2:	 Click Footer from the Header & Footer group. A gallery 

appears.
		  Step 3:	 Choose the style of your choice.
		  Step 4:	 Now, type the text for the footer.
		  Step 5:	 Click close Header and footer from the close group of 

Design tab.

Activity Zone	 Shift + F3
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Project Work
	 TAB — INSERT TAB
	 COMMAND — CLICK HEADER OR FOOTER
	 GROUP — “Header and Footer” group

Chapter - 7
Warm Up
1.	 It enhances our presentations with pictures, sound effects, tables and 

charts.
2.	 There are four views: Normal, Slide Sorter, Notes Page and Reading 

view.
3.      Notes Page

Exercise
A.	 1.	 (b) Presentation	 2.	 (a) Installed templates
	 3.	 (c) Side show view	 4.	 (c) 9	 5.	 (a) Page up
B.	 1.	 Powerpoint		  2.	 Ctrl + S	 3.	 Slide
	 4.	 Gradient			   5.	 Slide Sorter
C.	 1.	 T	 2.	 T	 3.	 T	 4.	 T	 5.	 T
D.1.	The basic purpose of any presentation is to communicate effectively.
2.	 It is a complete presentation software. It provides helpful suggestions 

on the layout, design and format of slides.
3.	 A slide is an individual page in a presentation.
4.	 A placeholder is a pre-formatted container on a slide for content (text, 

graphics or video).
5.	 The features are:
	 a.	 It gives us several ways to create a presentation.
	 b.	 Creating slides in the root of all our work with Powerpoint.
	 c.	 Adding text will help us put our ideas into words.
	 d.	 The multimedia features makes our slides Sparkle.
		  We can add clip art, sound effects, music, video clips, etc.
6.	 To start a new presentation, click the File tab in PowerPoint then select 

New. From the New tab in backstage View, you have two choices.
	 a.	 Start with a Blank Presentation. A blank presentation is a quick 

and easy way to start a new slide deck.
	 b.	 Start a New Presentation with a Template. Powerpoint comes with 

dozens of templates you can use for creating a new presentation.

Activity Zone : Do it yourself

Project work : Do it yourself
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Chapter - 8
Warm Up
	 1.	 True	 2.	 Yes	 3.	 True

Activity

	 1.	 	 2.	 	 3.	 	 4.	

	 5.	

Exercise
A.	 1.	 (a) Decision box	      2.   (a) Process box	 3.	 (c) Algorithm
	 4.	 (c) Alphanumerical	 5.	 (c) Both of these
B.	 1.	 Decision    2.  algorithm    3.  Ellipse     4.  Arrows	 5.   Input
C.	 1.	 T	 2.	 T	 3.	 T	 4.	 F	 5.	 T
D.1.	An algorithm is a sequence of well-defined instructions for completing 

a task or solving a problem.
2.	 a.	 It makes the problem solving easy to read and understand.
	 b.	 It is not dependent on any particular computer language.
3.	 A flowchart is a diagram that represents a process or algorithm. 
4.	 Arrows (Flow Lines)

	
5.	 Step 1: Start
	 Step 2: Input the first number (A) and the second number (B)
	 Step 3: Set the product (prod) to O
	 Step 4: Multiply A*B and store the result in prod.
	 Step 5: Output the product (prod)
	 Step 6: End

Activity Zone : Do it yourself	 Project work : Do it yourself

Chapter - 9
Warm Up
1.	 A computer network is an interconnection of various computer 

systems located at different places.
2.	 A Web browser is an application for accessing websites and the 

Internet.
3.	 E-mail stands for electronic mail. It is a communication method 

that uses electronic devices to deliver messages across computer 
networks.
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Activity
	 1.	 SERVER	 2.	 INTERNET	 3.	 PROTOCOL	 4.   EMAIL
	 5.	 ECOMMERCE		  6.	 GOOGLE
	 7.	 TELECONFERENCING	 8.	 GOOGLE MAP

Exercise
A.	 1.	 (c) WAN     2. (a) SERVER	 3. (a) Electronic mail      4. (b) LAN
B.	 1.	 T	 2.	 F	 3.	 T	 4.	 T
C.1.	 A computer network is an interconnection of various computer 

systems located at different places. The objectives are:
	 a.	 Resource sharing is the main objective of the computer network.
	 b.	 It is to provide the high reliability.
	 c.	 Computer organization has helped organization in saving money.
	 d.	 Computer network have provided means to increase system  

		 performance as the work load increases.
	 e.	 Computer network help people who live or work apart to report  

		 together.
	 f.	 Only authorized user can access resource in a computer network.
2.	 Teleconferencing refers to electronic meetings that involve people 

who are at physically different sites.
3.	 Difference between LAN and WAN

LAN WAN

a. LAN stands for local area 
network.

b. WAN stands for wide area 
network.

b. It is confined to a single 
building or group of building.

b. It is a computer network 
that spans a relatively large 
geographical area.

c. One LAN can be connected to 
other LANs over any distance 
via telephone lines and radio 
waves.

c. WAN consists of two or more 
local-area networks (LANs).

d. A system of LANs connected 
in this way is called a Wide 
Area Network (WAN).

d. Computers connected to 
a wide area network are 
often connected through 
public networks, such as the 
telephone system.

e. There are many different types 
of LANs taken ring networks, 
Ethernets and ARC nets being 
the most common for PCs

e. The largest WAN in existence 
is the Internet.
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4.	 The computer that provides resources to other computer on a network 
is known as a server.

Activity Zone : Do it yourself

Model Test Paper-1
A.	 1.	 (c) Both a and b    2.   (b) BIOS    3.  (b) Secondary   4. (b) Live tiles
B.	 1.	 Abacus	 2.	 ROM	 3.	 Secondary	 4.	 Recycle Bin
C.	 1.	 T	 2.	 T	 3.	 F	 4.	 T
D.1.	Charles Babbage is often referred to as the ‘Father of the Computer’. 

In the early 19th century he has given the idea of a programmed 
mechnical calculator known as the ‘Difference Engine’. Later 
he developed plans for ‘Analytical Engine’. His work inspired 
subsequent generation of engineers and inventors. Inventors and 
Engineers for the development of the first programmable digital 
computer in 21st century.

2.	 A pen drive can store important files and data backups, carry favorite 
settings or applications, run diagnostic to troubleshoot computer 
problems or launch an OS from a bootable USB.

3.	 Primary Memory is the memory that can be accessed directly by 
the CPU. There are two types of Primary Memory: RAM (Random 
Access Memory) and ROM (Read Only Memory).

	 RAM is a temporary memory.
	 ROM is a permanent memory.
4.	 We can change the color scheme by following some steps:
	 a.	 Select start
	 b.	 Click settings
	 c.	 Then click Personalization
	 d.	 Click colors
	 e.	 Then choose your own color.

Model Test Paper-2
A.	 1.	 (b) Three			   2.	 (b) Draw tab
	 3.	 (a) Paint bucket tool	 4.	 (a) Software
B.	 1.	 CSV	 2.	 Digital Notes
	 3.	 Properties	 4.	 Internet
C.	 1.	 F	 2.	 F	 3.	 F	 4.	 F
D.1.	The steps are:
	 a.	 Create a new document and type a letter or open an existing 

letter that you want to sent to different people at their respective 
addresses.
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	 b.	 Click on the mailings tab. In the Start Mail Merge group, click on 
the Start Mail Merge drop-down arrow and select the step by step 
Mail Merge Wizard option.

	 c.	 The Mail Merge task pane appears on the right side of the 
application window.

	 d.	 Now, select the letters radio button from the ‘select document 
type’ section.

	 e.	 Click on Next: Starting document under the ‘Step 1 of 6’ section at 
the bottom of the task pane.

		  A new task pane appears on the screen.
	 f.	 Click on the use the current document radio button under the 

‘Select Starting document’ section.
	 g.	 Click on Next: Select recipients under ‘Step 2 of 6’ section. Another 

task pane appears showing option for the defining recipients list.
2.	 You can easily convert handwriting to text via OCR technology. By 

a free scanner app like Adobe Scan, a smartphone, or an online OCR 
option, you can scan the handwriting with your smartphone.

3.	 The Paint Bucket tool allows you to select a color or texture and apply 
it to a model face. The Point Bucket tool is used for three primary 
tasks when modeling and rendering: Replacing a solid color or 
texture with a downloaded texture image from your Texture Library.

4.	 The three services provided by the Internet are:
	 a.	 E-commerce — It referes to the paperless exchange of business 

information using Electronic Data Interchange, Electronic mail, 
Electronic Bulletin Boards, etc.

	 b.	 Electronic Data Interchange (EDI) — It is the computer-to-
computer exchange of business documents in a standard format.

	 c.	 Voice Messaging — It is a new communication approach which is 
similar to electronic mail except that it is an audio message that is 
processed.

National Cyber Olympiad (Sample Paper)
	 1.	 (b) Delete			   2.	 (c) Bump 
	 3.	 (c)  A system preventing unauthorized access to a network
	 4.	 (d) All of these		  5.	 (d) Printer
	 6.	 (a) Rows and columns	 7.	 (d) Speaker
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